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Preface

The Sun Enterprise™ 10000 SSP 3.2 User Guide describes the System Service Processor

(SSP), which enables you to monitor and control the Sun Enterprise™ 10000 system.

How This Book Is Organized

This document contains the following chapters:

Chapter 1 introduces the System Service Processor (SSP).

Chapter 2 describes the Hostview Graphical User Interface (GUI).

Chapter 3 describes how to create, remove, rename, and bring up domains and also

describes how to get status information on a domain.

Chapter 4 describes how to use netcon (1M) and netcontool (1M).

Chapter 5 describes how to control the system’s power resources from within

Hostview or from the command line, to control the peripherals power resources

from the command line, and to monitor the power levels in Hostview.

Chapter 6 describes how to administer the thermal conditions and fans from within

Hostview and how to monitor and control the fans from within Hostview.

Chapter 7 describes how to configure components out of the system using the

blacklist file.

Chapter 8 describes the procedure for switching between the main and spare SSP.

Chapter 9 provides information on the use of two control boards.
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Chapter 10 provides more detailed information for system administrators interested

in how the SSP works. Included are descriptions of the SSP booting process and the

edd (1M) daemon that monitors the Sun Enterprise 10000 system.

Before You Read This Book

This manual is intended for Sun Enterprise 10000 system administrators who have a

working knowledge of UNIX® systems, particularly those based on the Solaris™

operating environment. If you do not have such knowledge, you should first read

the Solaris User and System Administrator AnswerBook2™ provided with this

system, and consider UNIX system administration training.

Using UNIX Commands

This document does not contain information on basic UNIX commands and

procedures such as shutting down the system, booting the system, and configuring

devices.

See one or more of the following for this information:

■ AnswerBook2 online documentation for the Solaris software environment,

particularly those dealing with Solaris system administration

■ Other software documentation that you received with your system
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Typographic Conventions

Shell Prompts

SSP Command Syntax

SSP commands ignore any unrecognized parameters used on the command line.

TABLE P-1 Typographic Conventions

Typeface or
Symbol Meaning Examples

AaBbCc123 The names of commands, files,

and directories; on-screen

computer output.

Edit your .login file.

Use ls -a to list all files.

% You have mail .

AaBbCc123 What you type, when

contrasted with on-screen

computer output.

% su
Password:

AaBbCc123 Book titles, new words or terms,

words to be emphasized.

Command-line variable; replace

with a real name or value.

Read Chapter 6 in the User’s Guide.

These are called class options.

You must be root to do this.

To delete a file, type rm filename.

TABLE P-2 Shell Prompts

Shell Prompt

C shell machine_name%

C shell superuser machine_name#

Bourne shell and Korn shell $

Bourne shell and Korn shell superuser #
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Related Documentation

Accessing Sun Documentation Online

The docs.sun.com SM web site enables you to access Sun technical documentation

on the Web. You can browse the docs.sun.com archive or search for a specific book

title or subject at:

http://docs.sun.com

TABLE P-3 Related Documentation

Application Title Part Number

Installation Sun Enterprise 10000 SSP 3.2 Installation Guide and
Release Notes

806-1502-10

Reference (man pages) Sun Enterprise 10000 SSP 3.2 Reference Manual 806-1501-10

Release Notes Sun Enterprise 10000 SSP 3.2 Installation and
Release Notes

806-1502-10

Other Sun Enterprise 10000 Dynamic Reconfiguration
User’s Guide

805-7985-10

Sun Enterprise 10000 Dynamic Reconfiguration
Reference Manual

805-7986-10

Sun Enterprise Server Alternate Pathing User’s
Guide

805-5985-10

Sun Enterprise Server Alternate Pathing Reference
Manual

805-5986-10
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Sun Welcomes Your Comments

We are interested in improving our documentation and welcome your comments

and suggestions. You can email your comments to us at:

docfeedback@sun.com

Please include the part number (806-1500-10) of your document in the subject line of

your email.
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CHAPTER 1

Introduction to the SSP

The System Service Processor (SSP) is a SPARC™ workstation or SPARC server that

enables you to control and monitor the Sun Enterprise 10000 system. You can use a

Sparcstation 5™, Sun Ultra 5™, or Sun Enterprise 250™ workstation or server as an

SSP. In this book, the SSP workstation or server is simply called the SSP. The SSP 3.2

software packages must be installed on the SSP. In addition, the SSP must be able to

communicate with the Sun Enterprise 10000 system over an Ethernet connection.

The Sun Enterprise 10000 system is often referred to as the platform. System boards

within the platform may be logically grouped together into separately bootable

systems called Dynamic System Domains, or simply domains. Up to 8 domains may

exist simultaneously on a single platform. (Domains are introduced in this chapter,

and are described in more detail in Chapter 3 “Domain Administration.”) The SSP

enables you to control and monitor domains, as well as the platform itself.

Note – Do not run any third party software on the SSP. (If you are using clusters,

you can run the Sun Cluster Console on the SSP. Clustering is beyond the scope of

this manual.)

SSP 3.2 Features

SSP 3.2 software can be loaded only on Sun workstations or Sun servers running the

Solaris 2.6 or Solaris 7 operating environment with the Common Desktop

Environment (CDE). SSP 3.2 software is compatible with Sun Enterprise 10000

domains that are running the Solaris 2.5.1, 2.6, or 7 operating environments. The

commands and GUI programs that are provided with the SSP 3.2 software can be

used remotely.
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The SSP enables the system administrator to perform the following tasks:

■ Boot domains.

■ Perform an emergency shutdown in an orderly fashion. For example, the SSP 3.2

software automatically shuts down a domain if the temperature of a processor

within that domain rises above a preset level.

■ Dynamically reconfigure a domain so that currently installed system boards can

be logically attached to or detached from the operating system while the domain

continues running in multiuser mode. This feature is known as Sun Enterprise
10000 dynamic reconfiguration and is described in the Sun Enterprise 10000 Dynamic
Reconfiguration User’s Guide. (A system board can easily be physically swapped in

and out when it is not attached to a domain, even while the system continues

running in multiuser mode.)

■ Create domains by logically grouping system boards together. Domains are able

to run their own operating system and handle their own workload. See Chapter 3

“Domain Administration”.

■ Assign paths to different controllers for I/O devices, which enables the system to

continue running in the event of certain types of failures. This feature is known as

Alternate Pathing (AP) and is described in the Sun Enterprise 10000 Alternate
Pathing 2.2 User’s Guide.

■ Monitor and display the temperatures, currents, and voltage levels of one or more

system boards or domains.

■ Control fan operations.

■ Monitor and control power to the components within a platform.

■ Execute diagnostic programs such as power-on self-test (POST).

In addition, the SSP environment:

■ Warns you of impending problems, such as high temperatures or malfunctioning

power supplies.

■ Notifies you when a software error or failure has occurred.

■ Automatically reboots a domain after a system software failure (such as a panic).

■ Keeps logs of interactions between the SSP environment and the domains.

■ Provides support for Inter-Domain Networks (IDN)

System Architecture

The Sun Enterprise 10000 platform, the SSP, and other workstations communicate

over Ethernet (FIGURE 1-1).
2 Sun Enterprise 10000 SSP 3.2 User Guide • November 1999



FIGURE 1-1 Enterprise 10000 System and Control Boards

Dual control boards are supported within the Sun Enterprise 10000 platform. Each

control board runs a control board executive (CBE) that communicates with the SSP

over a private network. One control board is designated as the primary control

board, and the other is designated as the alternate control board. Only one control

board is active at a time. If the primary control board fails, you can manually switch

to the alternate control board as described in Chapter 9 “Dual Control Board

Handling.”

SSP operations can be performed by entering commands on the SSP console or by

remotely logging in to the SSP from another workstation on the local area network.

Whether you log in to the SSP remotely or locally, you must log in as user ssp and

provide the appropriate password if you want to perform SSP operations (such as

monitoring and controlling the platform).

SSP User Environment

You can interact with the SSP and the domains on the Sun Enterprise 10000 by using

SSP commands and the SSP GUI programs.

Workstation

SSP

CBE

CBE

Control
Board 0

Control
Board 1

Sun Enterprise 10000

Control Board
Subnet 1

Control
Board
Subnet 2

LAN
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▼ To Begin Using the SSP

1. Boot the SSP.

2. Log in to the SSP as user ssp .

3. Type:

4. Wait until you see the following message:

At this point you can begin using SSP programs such as Hostview and

netcontool (1M).

SSP 3.2 Window

An SSP window provides a command line interface to the Solaris operating

environment and SSP 3.2 environment (FIGURE 1-2).

FIGURE 1-2 SSP Window

ssp% tail -f $SSPLOGGER/messages

Startup of SSP programs complete

SSP or Other Workstation Display

SSP% rlogin ssp \
-l ssp

SSP window
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▼ To Display an SSP Window Locally in the

Common Desktop Environment (CDE)

1. Log in to the SSP as user ssp .

2. Open an SSP window using one of the following methods:

■ From the CDE front panel under the Solaris 2.6 operating environment, select the

Personal Applications sub-panel (which looks like a notepad), and then select

Terminal.

■ From the CDE front panel under the Solaris 7 operating environment, select the

Hosts sub-panel, and then select This Host.

■ From the Workspace Menu (right mouse click) choose Programs and then choose

Terminal.

▼ To Display an SSP Window Remotely

1. Use the rlogin (1) command to remotely log in to the SSP 3.2 machine as user
ssp , and enter the ssp password.

2. When prompted, type in the name of the platform or domain with which you
want to work, and then press Return.

The SUNW_HOSTNAMEenvironment variable is set to the value you enter.

SSP Console Window

The SSP console window is the console for the SSP workstation or server. The system

uses it to log operating system messages.

▼ To Display an SSP Console Window Locally with

CDE

1. Log in to the SSP as user ssp .

2. Open an SSP window using one of the following methods:

■ From the Workspace Menu (right mouse click) choose Programs and then choose

Console. This method works under the Solaris 2.6 or Solaris 7 operating

environment.
Chapter 1 Introduction to the SSP 5



■ From the CDE front panel under the Solaris 7 operating environment, select the

Hosts sub-panel, and then select Console. This method works only under the

Solaris 7 operating environment.

Network Console Window

The network console window, or netcon (1M) window, receives system console

messages (operating system messages) from a domain (FIGURE 1-3).

FIGURE 1-3 netcon(1M) Window

A netcon (1M) window behaves as if a workstation were physically connected to a

domain. It also logs messages for operations such as dynamic reconfiguration of

system boards. For more information, see “Using netcon(1M)” on page 35 and the

netcon (1M) man page.

Hostview

The Hostview program provides a graphical user interface (GUI) with the same

functionality as many of the SSP commands (FIGURE 1-4).

Logical connection

Logical connection

Network

Sun Enterprise 10000

Domain 1

Domain 2

SSP
% domain_switch domain1_name

netcon(1M) windows

% netcon

% domain_switch domain2_name
% netcon
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FIGURE 1-4 Hostview GUI Program

Hostview is described in detail in Chapter 2 “Hostview”. It is also described in the

hostview (1M) man page in the Sun Enterprise 10000 SSP 3.2 Reference Manual.

SSP window

% hostview&

Hostview

SSP Network

Logical connection

Logical connection
Sun Enterprise 10000

Domain 1

Domain 2
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CHAPTER 2

Hostview

This chapter describes Hostview, the GUI front-end to SSP 3.2 commands.

Hostview enables you to perform administration operations such as:

■ Dynamically grouping the system boards into domains. Each domain runs its

own instance of the Solaris operating environment and has its own log messages

file.

■ Booting the Solaris operating environment for a domain.

■ Accessing the SSP log messages file for each platform or domain.

■ Remotely logging in to each domain.

■ Displaying a netcon (1M) window for each domain.

■ Editing the blacklist (4) file to enable or disable hardware components in a

domain.

■ Dynamically reconfiguring the boards within a platform, logically attaching or

detaching them from the operating system. This feature is described in the Sun
Enterprise 10000 Dynamic Reconfiguration User’s Guide.

■ Powering the system boards on and off.

■ Monitoring the temperature and voltage levels of hardware components.

If you want to run Hostview, you only need to run one instance for a given platform.

However, it is possible to run more than one instance simultaneously (perhaps on

different workstations) to work with the same platform.

If you have logged into the SSP environment from a remote login session, make sure

your DISPLAY environment variable is set to your current display and that your

xhost settings enable the SSP to display on your workstation (see xhost (1) in the

Solaris X Window System Reference Manual).
9



▼ To Start Up Hostview From a Remote Login

Session

1. Enable external hosts to display on your local workstation:

2. Log in to the SSP as user ssp and type:

▼ To Start Up Hostview From the Workspace

Menu Locally on the SSP

● From the Workspace Menu (right mouse button click), select SSP, and then select
Hostview.

This is available only when you use the SSP workstation, not when you use a remote

login session to the SSP.

▼ To Start Up Hostview Under CDE From the

Front Panel

● Use one of the following methods:

■ Click the SSP icon on the front panel. The icon shows a hand holding tools.

■ Click the arrow above the SSP icon on the front panel, and select Hostview.

■ Log in as user ssp :

% xhost +

ssp% setenv DISPLAY machine_name:0.0
ssp% hostview &

ssp% hostview &
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Hostview Main Window

When you start Hostview, the main window is displayed (FIGURE 2-1).

FIGURE 2-1 Hostview Main Window

The menu bar on the main window provides the commands that you use to control

the platform. The commands are described in “Main Window Menu Bar” on page 14.

The buttons on the main window (Power, Temperature, and Fans) bring up status

details. The buttons are described in “Main Window Buttons” on page 18.
Chapter 2 Hostview 11



The rest of the main window provides a graphical view of the platform boards and

buses. The system boards are named SB0 through SB15, and their processor numbers

are shown. The control boards are named CB0 and CB1. The support boards are

named CSB0 and CSB1. The buses are named ABUS0 through ABUS3, DBUS0, and

DBUS1.

The system boards along the top of the display are arranged in the order they appear

on the front side of the physical platform. The system boards along the bottom of the

display are arranged in the order they appear on the back side of the physical

platform.

If a system board is shown with no outline (FIGURE 2-2), the board is not part of a

domain and is not currently selected.

FIGURE 2-2 UnSelected System Board (domain independent)

If a system board is part of a domain (FIGURE 2-3), a colored outline surrounds it. The

boards within a given domain all have outlines of the same color.

FIGURE 2-3 UnSelected System Board (domain dependent)

A black outline around the domain color outline indicates that a board is selected

(FIGURE 2-4). (There are several reasons why you select a board in Hostview. For

example, you could select one or more boards, and then create a domain that is

based on those boards.)
12 Sun Enterprise 10000 SSP 3.2 User Guide • November 1999



FIGURE 2-4 Selected System Board (domain dependent)

The processors within the boards are numbered 0 through 63. The processor symbols

(diamond, circle, and so forth) indicate the state of the processors and are described

in “Main Window Processor Symbols” on page 19.

Selecting Items in the Main Window

You can select one or more boards in the Hostview main window. You can also select

one domain in the main window. You must select a set of boards prior to performing

certain operations, such as creating a domain.

■ To select a single board, click on it with the left mouse button. The selected board

is indicated by a black outline, and all other boards are deselected.

■ To select additional boards, click on them with the middle mouse button. You can

also deselect a currently selected board by clicking on it with the middle mouse

button. (The middle mouse button toggles the selection status of the board

without affecting the selection status of any other board.)

■ To select a domain, click on a board within that domain with the left mouse

button. Note that you can select boards from different domains (using the middle

mouse button), but the selected domain will correspond to the board that you

selected with the left mouse button.
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Main Window Menu Bar

The items on the main Hostview menu are described in TABLE 2-1.

TABLE 2-1 Hostview Menu Items

Menu Submenu Items Description

File SSP Logs Displays a window that shows the SSP

messages for a domain or for the platform.

For more information, see “SSP Log Files”

on page 21.

Quit Terminates Hostview.

Edit Blacklist File Enables you to specify boards and CPUs to

be blacklisted.

Control Power Displays a window that enables you to use

the power (1M) command. See “To Power

Components On or Off From Within

Hostview” on page 45.

Bringup Displays a window that enables you run

bringup (1M) on a domain. See “To Bring

Up a Domain From Within Hostview” on

page 32.

Fan Displays a window that enables you run the

fan (1M) command to control the fans

within the platform. See “To Control Fans

From Within Hostview” on page 55.

Configuration Board Enables you to attach and detach system

boards. This feature is described in the Sun

Enterprise 10000 Dynamic Reconfiguration
User’s Guide.
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Domain Provides a pull-right menu with several

choices. The menu choices enable you to

create domains, remove domains, rename

domains, obtain the status of domains, and

view the history of domains. A domain

consists of one or more system boards

running the same operating system kernel.

Domains function independently of each

other. Each domain can carry its own

workload and has its own log messages file.

For more information, see “To Create

Domains From Within Hostview” on

page 24 and “To Remove Domains From

Within Hostview” on page 28.

Terminal netcontool Displays a window that provides a

graphical interface to the netcon (1M)

command, enabling you to open a network

console window for a domain. This menu

item is equivalent to executing the

netcontool (1M) command. See “Using

netcon(1M)” on page 35.

SSP Provides pull-right menu choices that enable

you to display an SSP Window in xterm ,

dtterm , shelltool , or cmdtool format

with a platform or domain as its host. Select

a domain (by selecting any system board

within that domain) before choosing this

option.

rlogin Provides pull-right menu choices that enable

you to remotely log in to the selected

platform or domain in an xterm , dtterm ,

shelltool , or cmdtool window. Select a

domain (by selecting any system board

within that domain) before choosing this

option.

TABLE 2-1 Hostview Menu Items (Continued)

Menu Submenu Items Description
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Help Window

When you choose a topic from the Help menu, the Hostview - Help window is

displayed (FIGURE 2-5).

View All Domains Displays the boards within all domains, as

well as any boards that are not part of a

domain. (A board can be present without

being part of a domain, although a board

cannot be used when it is not part of a

domain.)

Individual Domains When you select an individual domain, only

the boards within that domain are

displayed. Note that the color of the outline

used to designate a given domain is also

used as the background color for that

domain in the menu. The system board

numbers for the boards that belong to each

domain are shown in square brackets.

Help topic Provides online help information on several

topics.

TABLE 2-1 Hostview Menu Items (Continued)

Menu Submenu Items Description
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FIGURE 2-5 Hostview Help Window

You can select the desired topic in the upper pane. The corresponding help

information is displayed in the lower pane.
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Main Window Buttons

The main Hostview window contains the buttons described below. If an out-of-

boundary condition exists or an error has occurred, one or more of these buttons

turn red.

The Power button (FIGURE 2-6) displays the Power Control and Status window,

which enables you to view the power status for the platform. See “To Power

Components On or Off From Within Hostview” on page 45.

FIGURE 2-6 Power Button

The Temperature button (FIGURE 2-7) displays the Thermal Status window, which

enables you to view the temperature status for the boards and components within

the platform. See “To Monitor Thermal Conditions From Within Hostview” on

page 51.

FIGURE 2-7 Temperature Button

The Fan button (FIGURE 2-8) displays the Fan Status window, which enables you to

view the status of the fans within the platform. See “To Monitor Fans From Within

Hostview” on page 53.

FIGURE 2-8 Fan Button
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When certain error conditions occur, the Failure button (FIGURE 2-9) turns red. If you

click a red Failure button, a window is displayed showing the error condition(s) that

have occurred.

FIGURE 2-9 Failure Button

TABLE 2-2 describes the types of error conditions that are trapped by this mechanism.

Main Window Processor Symbols

In the main window, the shape and background color of a processor symbol indicate

the status of that processor. For example, a diamond on a green background

indicates the processor is running the operating system.

TABLE 2-3 lists the shapes and what the processor is running for each shape.

TABLE 2-2 Error Conditions

Error Description

Host panic recovery in progress The operating system on a domain has failed and is

recovering.

Heartbeat failure recovery in

progress

The SSP was not receiving updated platform or

domain information as expected.

Arbitration stop recovery in

progress

A parity error or other fatal error has occurred, and

the domain is recovering. See arbitration stop in the

glossary.

TABLE 2-3 Processor Symbol Shapes

Shape Processor running

Diamond Operating system

Circle hpost (1M)
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TABLE 2-4 lists the possible colors for processor symbols and the processor state

indicated by each color.

Hostview Performance Considerations

Each instance of Hostview requires up to 10 Mbytes of the available swap space in

the SSP. Before running multiple copies of Hostview, make sure the SSP has

sufficient swap space available. For example, if you plan to run three instances of

Hostview, make sure you have at least 30 Mbytes of swap space.

Square download_helper

Triangle OBP

? Unknown program

TABLE 2-4 Processor Color Scheme

Color State

Green Running

Maroon Exiting

Yellow Prerun (The OS is currently being loaded.)

Blue Unknown

Black Blacklisted (The processor is unavailable to run programs or

diagnostics.)

Red Redlisted (The processor is unavailable to run programs or

diagnostics and its state may not be changed.)

White Present but not configured (The processor is unavailable, but not

blacklisted or redlisted. One example is a board that has been hot-

swapped in, but it has not yet been attached to the operating

system.)

TABLE 2-3 Processor Symbol Shapes

Shape Processor running
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SSP Log Files

When you perform procedures on an SSP, error messages for a particular domain are

logged in the file:

where domain_name is the host name of the domain for which the error occurred.

Error messages for the platform that are not specific to a domain are logged in the

$SSPLOGGER/messagesfile. The SSP environment variables, such as SSPLOGGER,
are described in “Environment Variables” on page 83.

▼ To View a messages File From Within Hostview

1. Select the appropriate board.

■ If you want to view the messages file for a particular domain, select that domain

in the main Hostview window (by clicking on a board from that domain with the

left mouse button).

■ If you want to view the messages file for the platform, make sure that no domain

is selected.

2. Choose SSP Logs from the File menu.

The SSP Logs window is displayed (FIGURE 2-10).

$SSPLOGGER/domain_name/messages
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FIGURE 2-10 SSP Logs Window

The Domain Name field shows the name of the domain that you selected. The

messages file is displayed in the main panel of the window.
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CHAPTER 3

Domain Administration

The SSP supports commands that let you logically group system boards into

Dynamic System Domains, or simply domains, which are able to run their own

operating system and handle their own workload. Domains can be created and

deleted without interrupting the operation of other domains. You can use domains

for many purposes. For example, you can test a new operating system version or set

up a development and testing environment in a domain. In this way, if problems

occur, the rest of your system is not affected.

You can also configure several domains to support different departments, with one

domain per department. You can temporarily reconfigure the system into one

domain to run a large job over the weekend.

Domain Configuration Requirements
You can create a domain out of any group of system boards, provided the following

conditions are met:

■ The boards are present and not in use in another domain.

■ At least one board has a network interface.

■ The boards have sufficient memory to support an autonomous domain.

■ The name you give the new domain is unique (as specified in the

domain_create (1M) command) and this name matches the host name of the

domain to be booted (as specified by the SUNW_HOSTNAMEenvironment variable).

■ You have an eeprom.image file for the domain that was shipped to you by the

factory. If your eeprom.image file has been accidentally deleted or corrupted

and you do not have a backup, see “To Recreate the eeprom.image File” on

page 27.
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There must be at least one boot disk connected to one of the boards that will be

grouped together into a domain. Alternatively, if a domain does not have its own

disk, there must be at least one network interface so that you can boot the domain

from the network.

▼ To Create Domains From Within Hostview

Note – Before proceeding, read the requirements in the previous section, “Domain

Configuration Requirements”. If the system configuration must be changed to meet

any of these requirements, call your service provider.

1. Click the left mouse button on the first board.

2. Click the middle mouse button on any additional boards.

Ensure that the boards you select do not currently belong to any domain.

3. Choose Domain then Create from the Configuration menu.

The Create Domain window is displayed (FIGURE 3-1).
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FIGURE 3-1 Create Domain Window

Caution – You must be sure to specify the proper OS Version number for the

domain you are creating. The default is 2.5.1. Edit this version number, if necessary,

to reflect the version of the operating system for the domain you are creating.

4. Type the domain name.

The name of the domain must be the one given to you by the factory and contained

in the eeprom.image file. It cannot be an arbitrary name.
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5. If all other fields are acceptable, click execute.

Note that the System Boards field indicates the boards that you selected in the main

Hostview window. The default OS version and the default platform type are shown.

If Hostview successfully executes the command, it displays the message Command
completed in the informational panel of the window.

Note – Hostview can run only one create or remove command at a time. If you

attempt to execute a second create or remove command before the first has

completed, your second attempt fails.

▼ To Create Domains From the Command Line

Note – Before proceeding, see “Domain Configuration Requirements” on page 23. If

the system configuration must be changed to meet any of these requirements, call

your service provider.

1. In an SSP window, type:

where:

domain_name is the name you want to give to the new domain. It should be unique

among all Sun Enterprise 10000 systems controlled by the SSP.

system_board_list specifies the boards that are to be part of this domain. The specified

system boards must be present and not in use. Each domain must have a network

interface, SCSI interface, and sufficient memory to support an autonomous system.

List the board numbers, separated by commas or spaces, for all boards you want to

include.

os_version is the version of the operating system to be loaded into the domain.

platform_name is the name of the platform managed by the SSP.

2. Optionally, create a new SSP window for the domain, as described in “SSP 3.2
Window” on page 4.

Use the domain_switch (1M) command to set the SUNW_HOSTNAMEenvironment

variable to the new domain name.

ssp% domain_create  -d domain_name - b system_board_list -o os_version -p
platform_name
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▼ To Recreate theeeprom.image File

Note – You cannot create a domain if you do not have the corresponding

eeprom.image file. The eeprom.image files for the domains you ordered are

shipped to you by the factory. If you accidentally delete an eeprom.image file or

your boot disk is corrupted, and you do not have a backup copy of your

eeprom.image file, you can contact your Sun service representative to recreate it.

Alternatively, you may be able to recreate the eeprom.image file if you have the

original serial number and the EEPROM key. In this case, follow the steps in this

procedure.

1. Log in to the SSP as user ssp .

2. Recreate the eeprom.image file.

Note – All key and host_id numbers are case sensitive and must be entered

exactly as they are received.

a. For the first domain, type:

where:

domain_name is the hostname of the domain

key is the eeprom key number

serial_number is the number provided with the key in the form of 0XA65xxx

b. For all subsequent domains, type:

where:

domain_name is the hostname of the domain.

key is the eeprom key number.

hostid is the number provided with the key in the form of 0X80A66xxx.

ssp% domain_switch domain_name
ssp% sys_id -k key -s serial_number

ssp% domain_switch domain_name
ssp% sys_id -k key -h hostid
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3. Check the result by typing:

In the following example, 49933C54C64C858CD4CF is the key and 0x80a66e05 is the

host_id:

4. Back up the SSP eeprom.image files to tape or disk where they can be accessed
in case of SSP boot disk failure.

▼ To Remove Domains From Within Hostview

1. In the main Hostview window, click any board in the domain to be removed.

2. Choose Domain then Remove from the Configuration menu.

The Remove Domain window is displayed (FIGURE 3-2 on page 29).

ssp% sys_id  -d

ssp% domain_switch domain_name
ssp% sys_id -k 49933C54C64C858CD4CF -h 0x80a66e05
ssp% sys_id -d

 IDPROM in eeprom.image. domain_name

                    Format = 0x01
              Machine Type = 0x80
          Ethernet Address = 0:0:be:a6:6e:5
        Manufacturing Date = Wed Dec 31 16:00:00 1998
Serial number (machine ID) = 0xa66e05
                  Checksum = 0x3f
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FIGURE 3-2 Remove Domain Window

3. If the default domain_remove (1M) command is satisfactory, click the execute
button; otherwise, edit the command first.

For help on the domain_remove (1M) command, click the help button. A help

window is displayed (see “Help Window” on page 16).

4. Specify whether or not domain subdirectories should be removed when you are
prompted to do so.

The pathnames of the subdirectories are displayed. These subdirectories contain

domain-specific information such as message files, configuration files, and

hpost (1M) dump files. You can keep these directories if you still need the

information. It is easier to recreate a domain if you keep these directories.

Note – If the system cannot remove your domain, see domain_remove (1M) for a

list of potential errors.
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▼ To Remove Domains From the Command Line

1. Type:

You must execute this command in an SSP window in which the SUNW_HOSTNAME
environment variable is set to the name of the domain you want to remove. The

domain must not be running the operating system.

2. Specify whether or not domain subdirectories should be removed when you are
prompted to do so.

The pathnames of the subdirectories are displayed. These subdirectories contain

domain-specific information such as message files, configuration files, and

hpost (1M) dump files. You can keep these directories if you still need the

information. The domain can be recreated whether or not you keep this information.

3. Type domain_status (1M) to verify that the domain was removed.

Note – If the system cannot remove your domain, an error message is displayed.

See domain_remove (1M) for a list of potential errors.

▼ To Rename Domains From Within Hostview

Note – After you rename a domain, you must also update /etc/hosts to reflect

the domain’s new name.

1. Shut down the domain.

2. In the main Hostview window, select a board from the domain that you want to
rename by clicking on it with the left mouse button.

3. Choose Domain then Rename from the Configuration menu.

The Rename Domain window is displayed (FIGURE 3-3).

ssp% domain_remove -d domain_name
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FIGURE 3-3 Rename Domain Window

4. If the default domain_rename (1M) command is satisfactory, click on the execute
button. Otherwise, edit the command first.

For help on the domain_rename (1M) command, click on the help button. A help

window is displayed (see “Help Window” on page 16).

▼ To Rename Domains From the Command Line

Note – After you rename a domain, you must also update the standard host

configuration files to reflect the domain’s new name. See the Solaris 2.6 User

Collection or Solaris 7 User Collection and the Solaris 2.6 System Administrator

Collection Vol 1 or Solaris 7 System Administrator Collection.
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● Type:

For more information, see the domain_rename (1M) man page.

▼ To Bring Up a Domain From Within Hostview

1. Use the mouse to select any system board belonging to the domain you want to
bring up.

2. Choose Bringup from the Control menu.

A window is displayed that shows the name of the selected domain.

3. Click Execute to perform the bringup.

4. After the bringup operation has completed, choose netcontool from the
Terminal menu.

5. Click the Connect button to open a netcon (1M) window.

6. If the OBP prompt appears (that is, the OKprompt), boot the domain:

The domain should boot and then display the login prompt. Note that you can use

the OBP command devalias to determine the alias for the disk you want to use as

boot_device.

▼ To Bring up a Domain From the Command Line

Before you can bring up a domain from the command line in an SSP window, the

system boards for the domain must be powered on. Ensure that the

SUNW_HOSTNAMEenvironment variable is set to the proper valid domain name.

1. Set the SUNW_HOSTNAMEenvironment variable by typing:

where domain_name is the name of the domain you want to bring up.

% domain_rename -d old_domain_name-n new_domain_name

OK boot boot_device

ssp% domain_switch domain_name
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2. Power on the power supplies for all of the boards in the domain:

3. Bring up the domain by typing:

The -A option is the autoboot option. If the autoboot option is on, the domain will

automatically boot. If it is off, you need to explicitly boot the domain.

▼ To Obtain Domain Status From Within Hostview

● Choose Domain then Status from the Configuration menu.

The Domain Status window is displayed (FIGURE 3-4).

ssp% power -on

ssp% bringup -A [off/on] [ disk]
ssp% netcon
ok boot
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FIGURE 3-4 Domain Status Window

The status listing is displayed in the main panel of the window. The following table

explains the columns in the Domain Status window.

TABLE 3-1 Domain Status Columns

Name Description

DOMAIN Lists the name of the domain.

TYPE Lists the platform type. It can only have the value

Ultra-Enterprise-10000 in the current release.

PLATFORM Lists the name of the platform. The platform name is set at the time

the SSP packages are installed.

OS Lists the operating system version for the domain.

SYSBDS Lists the system boards that make up the domain.
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CHAPTER 4

netcon and netcontool

This chapter describes netcon (1M) and netcontool (1M), the GUI front-end to the

netcon (1M) command. netcontool (1M) simplifies the process of configuring and

bringing up netcon (1M) windows. You can also use the netcon (1M) command

directly to display a netcon (1M) window. However, when using netcon (1M), you

must know escape sequences to perform operations that can be performed by

clicking on buttons under netcontool (1M).

Using netcon (1M)
The netcon (1M) command is similar to netcontool (1M) except that no GUI

interface is provided, making it more functional for dial-in or other low-speed

network access. Typically, you log in to the SSP machine as user ssp , and enter the

netcon (1M) command in an SSP window. For example:

This action changes the window in which you run the netcon (1M) command into a

netcon (1M) window for the domain specified by the domain_switch (1M)

command. Multiple netcon (1M) windows can be open simultaneously, but only one

at a time can have write privileges to a specific domain. When a netcon (1M)

window is in read-only mode, you can view messages from the netcon (1M)

window, but you cannot enter any commands.

You can specify the netcon (1M) -g option for Unlocked Write permission, -l for

Locked Write permission, -f to force Exclusive Session mode, or -r for read-only

mode. See the netcon (1M) man page for an explanation of how netcon (1M)

behaves if you do not specify any of these arguments.

ssp% domain_switch  domain_name
ssp% netcon
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If you have write permission, you can enter commands. In addition, you can enter

special commands with the tilde (~) prefix to perform the functions offered by the

netcontool (1M) window.

If netcon (1M) displays the following message, “netcon_server is not
running for domain_name”, the domain may not be up. If it is up, you can run

“netcon_server -r & ” to restart netcon_server (1M).

▼ To Startnetcon (1M) From the Command Line

● Log in to the SSP as user ssp and type:

▼ To Startnetcon (1M) From the CDE Front Panel

1. From the CDE front panel, select the SSPsubpanel and then select the netcon
option.

2. Specify the domain name when prompted to do so.

▼ To Startnetcon (1M) From the CDE Workspace
Menu

1. From the CDE Workspace menu (right click), choose SSP and then choose netcon.

2. Specify the domain name when prompted to do so.

ssp%  domain_switch  domain_name
ssp%  netcon
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▼ To Exit From anetcon (1M) Window

● Type a tilde (~) followed by a period in the netcon (1M) window:

If you enter the tilde period sequence locally at the SSP workstation or remotely

through a telnet (1) session, your netcon (1M) session is terminated and the

window returns to its previous state. However, if you enter the tilde period sequence

remotely through an rlogin (1) session, the netcon (1M) session is terminated and
the rlogin (1) window is deleted as well. This is because the tilde period sequence

is recognized by rlogin (1) as an exit command. If you want to avoid this behavior,

you can use the sequence ~~., that is, tilde tilde period, to exit from a netcon (1M)

window running inside of an rlogin (1) session. For more information about escape

sequences, see the netcon (1M) manual page.

Using netcontool (1M)
The netcontool (1M) GUI program provides the buttons shown in FIGURE 4-1.

FIGURE 4-1 netcontool GUI Program

TABLE 4-1 explains the netcontool (1M) buttons.

# ~.

TABLE 4-1 netcontool buttons

Button Description

Configure Displays the Console Configuration window. See “To Configure the

netcontool(1M) Window” on page 40.

Connect Displays the netcon (1M) window and initiates the connection

process.

Disconnect Disconnects the console window from the domain and removes the

console window. The netcontool (1M) window is still available so

that you can reconfigure for another connect session.

OBP/kadb Breaks to the OpenBoot™ PROM (OBP) or kadb (1M) programs.
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▼ To Display anetcontool (1M) Window From the
Command Line

● Log in to the SSP as user ssp and type:

▼ To Display anetcontool (1M) Window From the
CDE Front Panel

1. From the CDE front panel, select the SSPsubpanel and then select the
netcontool option.

2. Specify the domain name when prompted to do so.

JTAG Toggles the SSP-to-platform connection between a network

connection and a JTAG connection.

Locked Write,

Unlocked Write, and

Exclusive Write

Request the corresponding mode for the console window. For an

explanation of the meaning of these modes, see “To Configure the

netcontool(1M) Window” on page 40.

Release Write Releases write access and places the console in read only mode.

Status Displays information about all open consoles that are connected to

the same domain as the current session, as well as the connection

type currently used.

Help Displays information about the netcontool (1M) window.

Exit Exits the program and removes the netcon (1M) window if it is still

open.

ssp% domain_switch domain_name
ssp% netcontool &

TABLE 4-1 netcontool buttons

Button Description
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▼ To Display anetcontool (1M) Window From the
CDE Workspace Menu

1. From the CDE Workspace menu (right click), choose SSP and then choose
netcontool.

2. Specify the domain name when prompted to do so.

▼ To Display thenetcontool (1M) Window From
Hostview

1. Select a board from the domain for which you want to display a netcontool (1M)
window by clicking on that board with the left mouse button.

2. Select Terminal ‰ netcontool .

3. In the netcontool (1M) window, click the Connect button.

The netcontool (1M) window (FIGURE 4-2) is displayed beneath the

netcontool (1M) buttons.

FIGURE 4-2 netcontool Window in Hostview
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▼ To Configure thenetcontool (1M) Window

1. Click the Configure button if you want to configure the netcontool (1M) window
before you display a netcon (1M) window.

The Console Configuration window is displayed (FIGURE 4-3).

FIGURE 4-3 netcontool Console Configuration Window

2. Select the session type in the left panel, and the terminal emulation type in the
right panel.
40 Sun Enterprise 10000 SSP 3.2 User Guide • November 1999



3. When you are satisfied with the contents of the window, click Done to accept the
settings and dismiss the window, or click Apply to accept the settings without
dismissing the window.

The following table contains the options in the Console Configuration window.

TABLE 4-2 Console Configuration Options

Console Options

Default Session This causes the default type of session to be started. If no other

session is running, the default is unlocked-write mode. If any other

session is running, the default is read-only mode.

Read Only Session Displays a console window where you can view output from a

domain, but you cannot enter commands.

Unlocked Write

Session

Attempts to display a netcon (1M) window with unlocked write

permission. If this attempt succeeds, you can enter commands into

the console window, but your write permission is taken away

whenever another user requests Unlocked Write, Locked Write, or

Exclusive Session permission for the same domain.

• If another user currently has Unlocked Write permission, it is

changed to read-only permission, and you are granted Unlocked

Write permission.

• If another user currently has Locked Write permission, you are

granted read-only permission.

• If another user currently has Exclusive Session permission, you

are not allowed to display a netcon (1M) window.

• If you are granted Unlocked Write permission and another user

requests Unlocked Write or Locked Write permission, you are

notified and your permission is changed to read only. You can

attempt to re-establish Unlocked Write permission at any time,

subject to the same constraints as your initial attempt to gain

Unlocked Write permission.
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netcon (1M) Communications
netcon (1M) uses two distinct paths for communicating console input/output

between the SSP and a domain: the standard network interface and the CBE

interface. When the domain is up and running, console traffic usually flows over the

network. If the local network becomes inoperable, all interactive access to the

domain is lost and, for example, telnet , rlogin , and netcon (1M) sessions hang.

In this case, you can switch to the CBE interface and access the host’s console

window. To perform this switch, use the ~= command in the netcon (1M) window.

Locked Write Attempts to display a console window with Locked Write

permission.

• If you are granted Locked Write permission, no other user can

remove your write permission unless they request Exclusive

Session permission.

• If another user currently has Locked Write permission, you are

granted read-only permission.

• If another user currently has Locked Write permission, you are

granted read-only permission.

• If another user currently has Exclusive Session permission, you

are not allowed to display a netcon (1M) window.

Exclusive Session Displays a console window with Locked Write permission,

terminates all other open console sessions for this domain, and

prevents new console sessions for this domain from being started.

You can change back to multiple session mode by clicking the

Release Write button to release write access, or by clicking the

Disconnect button to terminate your console session for the domain.

You can also simply quit from the console window (using the

Control menu of the window). You are not granted Exclusive

Session permission if any other user currently has Exclusive Session

permission.

Terminal Emulation

Type

The netcon (1M) window is brought up in the specified type of

window. The default is xterm (1). dtterm (1) is only available if you

are running the Common Desktop Environment (CDE), otherwise it

is grayed out. You can also use shelltool (1) or cmdtool (1).

TABLE 4-2 Console Configuration Options (Continued)

Console Options
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netcon (1M) Message Logging
Certain messages sent from the kernel are not displayed in the syslog messages file,

such as OpenBoot messages, panic messages, and some console messages.

syslogd (1M) must run on the host to log the messages; this is not possible when a

panic occurs, nor is it possible at certain times during the boot sequence. Moreover,

panic dumps often fail, so these types of messages may not even appear in a dump

file to help you determine the cause of the failure.

However, you can capture all output displayed on an active netcon (1M) console

through the LOCAL1 facility of syslog (1M) and the SSP machine_server (1M)

daemon. This functionality is enabled through the /etc/syslog.conf and

$SSPLOGGER/.logger files. When enabled, netcon (1M) session output is recorded

in the $SSPLOGGER/domain_name/netcon file, where $SUNW_HOSTNAMEis set to the

host name for the domain. By default, this functionality is disabled.

▼ To Enablenetcon (1M) Logging

1. In the file /etc/syslog.conf , uncomment the local1.debug line.

2. Force syslogd to reread its configuration file:

▼ To Disablenetcon (1M) Logging Sessions for
Specific Hosts

Once logging of netcon sessions is enabled as shown above, logging can be disabled

for specific domains.

● Start netcon_server with the -S flag for a specific domain.

ssp# kill -HUP ‘cat /etc/syslog.pid‘

ssp% domain_switch domain_name
ssp% netcon_server -r -S &
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The S flag, to suspend netcon session output, can also be used with bringup ,

which passes the flag on to netcon_server , for example:

Either method disables output for netcon sessions when otherwise enabled with

the syslog.conf and .logger files.

▼ To Re-Enablenetcon (1M) Logging Sessions for
Specific Hosts

If you have disabled netcon (1M) logging as described in “To Disable netcon(1M)

Logging Sessions for Specific Hosts”, you can re-enable netcon (1M) logging.

● Start netcon_server :

ssp% bringup -S

ssp% domain_switch domain_name
ssp% netcon_server -r &
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CHAPTER 5

Power Administration

This chapter describes how to control the system power resources from within

Hostview or from the command line, to control the peripherals power resources

from the command line, and to monitor the power levels in Hostview.

▼ To Power Components On or Off From Within
Hostview

Note – If you are powering off a board to replace it, use the power (1M) command.

Do not use the breakers to power off the board; this can cause an arbstop.

1. Click the left mouse button to select a board in the main Hostview window.

2. Choose Power from the Control menu.

The Power Control and Status window is displayed (FIGURE 5-1 on page 46).
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FIGURE 5-1 Power Control and Status Window

The default power (1M) command is displayed in the Command field.

3. Optionally, add options to the power (1M) command.

4. Click the Execute button (or press Return) to run the command.

The results are shown in the main panel of the window.

5. For information about the power (1M) command, click the Help button.

A help window is displayed. See “Help Window” on page 16.

After powering on the necessary components, you can run the bringup (1M)

commands on the SSP for the domains you want to boot. See “To Bring Up a Domain

From Within Hostview” on page 32.

If you try to power off the system while any domain is actively running the

operating system, the command fails and a message is displayed in the message

panel of the window. In this case, you have two choices. You can force a power off

by executing the power (1M) command again with the f (force) option. Or, you can

issue a shutdown (1M) or similar command for the active domain(s) to gracefully
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shut down the processors, and then reissue the command to power off. Using

shutdown (1M) ensures that all resources are de-allocated and users have time to log

out before the power is turned off. To use shutdown (1M), you must be logged in to

the domain as superuser.

If the platform loses power due to a power outage, Hostview displays the last state

of each domain before power was lost.

▼ To Power System Boards On and Off From the
Command Line

● To power on system boards, type:

where board_list is a list of system boards separated by spaces, such as

3 5 6 .

Note – If you are powering off a board to replace it, use the power (1M) command.

Do not use the breakers to power off the board; this can cause an arbstop.

● To power off system boards, type:

where board_list is a list of system boards separated by spaces, such as

3 5 6 .

For more information, see the power (1M) man page.

▼ To Monitor Power Levels in Hostview

1. Click the Power button.

ssp% power -on -sb board_list

ssp% power -off -sb board_list
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FIGURE 5-2 Power Button

The Power Status Display window is displayed (FIGURE 5-3 on page 48).

FIGURE 5-3 Power Status Display

In FIGURE 5-3, the bulk power supplies are named PS0 through PS07. The system

board power supplies are numbered 0 through 15. The support board power

supplies are named CSB0 and CSB1. The control board power supplies are named

CB0 and CB1.

Power supplies can be colored green, red, or gray. A green power supply is

functioning properly. A red power supply has failed. A gray power supply is not

present.

2. Click on a system board.

The Power Detail window for that board is displayed (FIGURE 5-4 on page 49).

System board power
supplies (0 through 15)

Bulk power

(both sides)
supplies

Support
board power
supplies
(both sides)

Control
board power
supplies
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FIGURE 5-4 System Board Power Detail Window

The Power Detail window shows the voltage for each of the five power supplies on

the board. The power levels are indicated in volts. The bars give a visual

representation of the relative voltage levels so that you can monitor them more

easily. If a bar is green, the voltage level is within the acceptable range. If a bar is

red, the voltage level is either too low or too high. (Thus, a red bar can be short or

tall.) The bars never grow taller than the height of the window, so voltage levels that

exceed the maximum threshold are displayed as red maximum-height bars.

Similarly, bars never shrink below a minimum height, so voltage levels below the

minimum threshold are displayed as red minimum-height bars.

The only difference between the detail for a system board and the detail for a control

board or support board is the number of power supplies.
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CHAPTER 6

Thermal Conditions Administration

This chapter describes how to administer the thermal conditions and fans from

within Hostview and how to monitor and control the fans from within Hostview.

▼ To Monitor Thermal Conditions From Within
Hostview

You can use Hostview to monitor thermal conditions for power supplies, processors,

ASICs, and other sensors located on system boards, support boards, controller

boards, and the centerplane.

1. Click the Temperature button.

FIGURE 6-1 Temperature Button

The Thermal Status Display window is displayed (FIGURE 6-2 on page 52).
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FIGURE 6-2 Thermal Status Display

The centerplane, support boards, control boards, and system boards are shown in

green if their temperatures are in the normal range, and in red otherwise.

2. Click on a component with the left mouse button to see the thermal details about
that component.

The Thermal Detail window for that component is displayed (FIGURE 6-3 on page 53).
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FIGURE 6-3 System Board Thermal Detail

The left panel of the system board detail shows the temperatures for the five ASICs,

named A0 through A4. The middle panel shows the temperatures for the three

power supplies. The right panel shows the temperatures for the four processors,

named P0 through P3.

The temperatures are displayed in degrees centigrade, and the values are shown

numerically and as vertical bars. The vertical bars are colored green if the

temperature is within the normal range, and red otherwise. The bars never grow

taller than the height of the window, so temperature levels above the maximum

threshold are displayed as red maximum-height bars. Similarly, bars never shrink

below a minimum height, so temperature levels below the minimum threshold are

displayed as red minimum-height bars.

The detail windows for control boards, support boards, and the center plane are

similar.

▼ To Monitor Fans From Within Hostview

You can use Hostview to monitor fan speeds and fan failures for the 32 fans located

throughout the Sun Enterprise 10000 platform.

1. Click on the Fan button.

FIGURE 6-4 Fan Button

The Fan Status Display window is displayed (FIGURE 6-5 on page 54).
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FIGURE 6-5 Fan Status Display

The fan trays are named FT0 through FT7 on the back, and FT8 through FT15 on the

front. Each fan tray contains two fans. The color of the fan tray symbol is green if

both fans in the tray are functioning at normal speed, amber if both fans are

functioning at high speed, and red if either fan within the fan tray has failed.

2. Click on a fan tray symbol with the left mouse button to see a detail window
about that fan.

The Fan Tray window is displayed (FIGURE 6-6 on page 55).
54 Sun Enterprise 10000 SSP 3.2 User Guide • November 1999



FIGURE 6-6 Fan Tray Window

The top circle indicates the inner fan when you open the fan tray, and the lower

circle indicates the outer fan. The color surrounding each circle in the fan detail

indicates the status of that fan. The colors are green for normal operation at normal

speed, amber for normal operation at high speed, and red for failure.

▼ To Control Fans From Within Hostview

You can control fan power and speed from within Hostview.

1. Choose Fan from the Control menu.

The Fan Control and Status window is displayed (FIGURE 6-7 on page 56).
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FIGURE 6-7 Fan Control and Status Window

The Domain Name field shows the selected domain from the platform to which

Hostview is connected. The fan (1M) command is shown in the Command field

without any options.

2. Add the desired set of options to the fan (1M) command, and click the execute
button (or press Return).

For example, if you want to set the fans on the front fan shelves to high speed, type:

For information on the fan (1M) command, click the Help button. A help window is

displayed (see “Help Window” on page 16). Or, refer to the fan (1M) man page.

fan -s fast
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CHAPTER 7

Blacklist Administration

The blacklisting feature enables you to configure the following components out of

the system:

■ System boards

■ Processors

■ Address buses

■ Data buses

■ Data routers

■ I/O controllers

■ I/O adapter card

■ System board memory

■ Memory DIMM groups

■ Sun Enterprise 10000 half-centerplane

■ Port controller ASICs

■ Data buffer ASICs

■ Coherent interface controller ASICs

■ 72-bit half of 144-bit, local, data router within system boards

Generally, you may want to blacklist a component if you believe that component is

having intermittent problems, or if it is failing sometime after the system is booted.

If a component has a problem that shows up in the power-on self-test (POST) run by

hpost (1M) (which is run by the bringup (1M) command), that component is

automatically configured out of the system by hpost (1M). However, that

component is not blacklisted. hpost (1M) is run on the components in the system

before a domain is booted, and on the components on a given board before that

board is attached with Dynamic Reconfiguration (DR). See the Sun Enterprise 10000
Dynamic Reconfiguration User’s Guide.

To blacklist a component, you can edit the blacklist (4) file with a text editor, or

use Hostview. Hostview does not allow you to blacklist all possible components, so

there may be times when you need to edit blacklist (4) directly. When a domain
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runs POST, hpost (1M) reads the blacklist (4) file and automatically excludes the

components specified in that file. Thus, changes that you make to the blacklist (4)

file do not take effect until the domain is rebooted.

The file is $SSPVAR/etc/ platform_name/blacklist , where platform_name is the

name of the platform. See the blacklist (4) man page for information about the

contents of the blacklist (4) file.

▼ To Blacklist Components From Within Hostview

1. Choose Blacklist File from the Edit menu.

The Blacklist Edit window is displayed (FIGURE 7-1).

FIGURE 7-1 Blacklist Edit Window—Board View
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2. Select the boards and/or buses that you want to place onto the blacklist.

To select a single component and deselect all other components of that type (for

example, to select a single board and deselect all other boards), click on that

component with the left mouse button. To toggle the selection status of a single

component without affecting the selection status of any other component, click on

that component with the middle mouse button. The selected components are

displayed in black.

3. To save the changes, choose Save from the File menu.

4. To exit the Blacklist Edit window, choose Close from the File menu.

If you have unsaved changes and you close the Blacklist Edit window by choosing

Close from the File menu, you are prompted to save the changes.

▼ To Blacklist Processors From Within Hostview

1. Choose Blacklist File from the Edit menu.

The Blacklist Edit window is displayed.

2. From the Blacklist Edit window, choose Processors from the View menu.

The Blacklist Edit window displays the Processor View window (FIGURE 7-2).
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FIGURE 7-2 Blacklist Edit Window—Processor View

3. Select the processors that you want to add to the blacklist.

To select a single processor on a board and deselect all other processors on that

board, click on that processor with the left mouse button. To toggle the selection

status of a processor on a board without affecting the selection status of any other

processors on that board, click on that processor with the middle mouse button. The

selected processors are displayed in black.

4. To save the changes, choose Save from the File menu.

5. To exit the Blacklist Edit window, choose Close from the File menu.

If you have unsaved changes and you close the Blacklist Edit window by choosing

Close from the File menu, you are prompted to save the changes.
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▼ To Clear the Blacklist File From Within Hostview

1. In Hostview, choose Blacklist File from the Edit menu.

2. From the Blacklist Edit window, choose New from the File menu.

3. From the Blacklist Edit window, choose Close from the File menu.
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CHAPTER 8

Using a Spare SSP

The SSP is a Sun workstation or Sun server with a defined hardware configuration.

You can use a Sparcstation 5, Sun Ultra 5, or Sun Enterprise 250 workstation or

server as an SSP. You can also use one of these three systems as a spare SSP to serve

as a backup if your main SSP fails. In addition, you can order a Sun Enterprise 10000

server with a spare SSP.

Maintain a spare SSP in a ready state. This allows you to quickly switch to the spare

SSP if the main SSP fails. Do not run any third party software on the spare SSP. (If

you are using clusters, you can run the Sun Cluster Console on the main SSP.

Clustering is beyond the scope of this manual.)

To maintain a spare SSP, you must adhere to the following requirements:

■ The spare SSP must be properly configured to function in the same way as the

main SSP within the network.

■ You must not install or use any third party software on the SSP.

■ Any changes that you make to the main SSP must be made to the spare SSP as

well. After any system configuration operation, you must immediately run

ssp_backup (1M) on the main SSP. If the main SSP crashes, you will have a

backup file that you can restore to the spare SSP by running ssp_restore (1M).

For more information about ssp_backup (1M) and ssp_restore (1M), see “To

Switch Between the Main and Spare SSP” on page 64 and the ssp_backup (1M)

and ssp_restore (1M) man pages in the Sun Enterprise 10000 SSP 3.2 Reference
Manual.

Note – You can run any combination of SSP versions 3.1, 3.1.1 and 3.2 on the main

and spare SSP machines provided you are not using IDN. If you are using IDN, both

the main and spare SSP must be running SSP 3.2.
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▼ To Switch Between the Main and Spare SSP

1. Verify that the main SSP is correctly configured for switching to the spare SSP.

If the main SSP is running SSP 3.2 and the spare SSP is running SSP 3.1 or 3.1.1 and

you are using IDN on the main SSP, you must do the following prior to switching to

the spare SSP:

a. On the main SSP, unlink all IDN domains.

See domain_unlink (1M).

b. On the domains, remove all /etc/hostname.idn x files, where x is an integer.

c. On each IDN domain, halt the domain and set the idn-smr-size environment
variable to zero.

d. Reboot domains the domains you halted in Step c.

Refer to the Sun Enterprise 10000 Inter-Domain Network User Guide.

2. Change the main SSP to a spare SSP:

a. Log in to the main SSP as superuser.

b. Type:

This command backs up the SSP configuration information to the file

backup_dir/ssp_backup.cpio .

c. Type:

3. Change the spare SSP to a main SSP:

a. Log in to the spare SSP as superuser.

ssp# /opt/SUNWssp/bin/ssp_backup backup_dir

ssp# /opt/SUNWssp/bin/ssp_config
Beginning setup of this workstation to act as a MAIN or SPARE SSP.
Are you currently configuring the MAIN SSP? (y/n)n
SPARE SSP configuration completed.
ssp#
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b. Restore the ssp_backup.cpio file that you created in Step 2 by typing:

where backup_dir is the directory in which the backup file is located.

Note – Do not change the SSP environment between the time you run

ssp_backup (1M) and ssp_restore (1M). For example, after you run

ssp_backup (1M), do not shut down a domain, bring up a domain, or power boards

on or off until you run ssp_restore (1M).

c. Change the spare SSP to be the main SSP by typing:

Note – Verify that all SSP daemons have started before proceeding.

d. If this SSP is running the SSP 3.1 software, reboot the SSP.

4. For each domain on the host, perform the following steps.

If a domain is down when you perform this procedure, the console window may be

unusable after the domain is brought up by the spare SSP. If the console is unusable,

perform these steps using an rlogin or telnet session.

a. From the new main SSP, or from another workstation on the network, rlogin
to the domain as superuser.

ssp# /opt/SUNWssp/bin/ssp_restore backup_dir/ssp_backup.cpio

ssp# /opt/SUNWssp/bin/ssp_config spare
Configuring the spare SSP to control the Host

Beginning set up of the SPARE SSP workstation to control the host.

Platform name = allxf4
Control board 0 = xf4-cb0 => 129.153.151.123
Control board 1 = xf4-cb1 => 129.153.152.123
Primary Control Board = 0

Is this correct? (y/n)y

This SPARE SSP is NOW configured to control the host.

This machine is the MAIN SSP now.
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b. Edit the /etc/ssphostname file to replace the hostname of the main SSP with
the hostname of the spare SSP.

For example, if your main SSP is called xf4-ssp and your spare SSP is called

xf4-ssp2 , change the contents of /etc/ssphostname to xf4-ssp2 .

c. Switch console communication from the main SSP to the spare SSP:

where cvcd_path is /sbin under the 2.6 operating environment, and cvcd_path is

/platform/SUNW,Ultra-Enterprise-10000/lib/cvcd under the Solaris 7

operating environment.

d. If needed, update the /etc/syslog.conf file on each domain to replace the
hostname of the main SSP with the hostname of the spare SSP.

# ps -ef | grep cvcd
# kill -9 cvcd_pid
# cvcd_path/cvcd
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CHAPTER 9

Dual Control Board Handling

A platform can be configured with dual control boards for redundancy purposes.

Although you can manually switch between the control boards, only one control

board at a time is used by the system.

One of the control boards is identified as the primary control board. The SSP

attempts to communicate only with the primary control board. If you decide that it

is necessary to switch the primary control board because of a connection failure or

for other reasons, you must modify the control board configuration file and reboot

the SSP to activate the new primary control board. Note that this operation cannot

be performed without rebooting all running domains because the control board

provides the system clocks for all boards.

Control Board Executive
The control board executive (CBE) runs on the control board and facilitates

communication between the SSP and the platform.

When power is applied, both control boards boot from the SSP that is serving as the

boot server. After the CBE is booted, it waits for the control board server running on

the SSP to establish a connection.

Primary Control Board
When the control board server running on the SSP connects to the CBE running on a

control board, the CBE asserts the control board as the primary control board. The

primary control board is responsible for providing the system clock and JTAG clock

and for controlling fan trays and bulk power supplies.
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Control Board Server
After the SSP is booted, the control board server (CBS), is started automatically. The

CBS is responsible for all communication between the SSP and the primary control

board.

The CBS attempts to connect only to the primary control board identified in the

control board configuration file. The format of the file is as follows:

where:

platform_name is the name assigned by the system administrator.

platform_type is defaulted to Ultra-Enterprise-10000 .

cb0_hostname is the host name for control board 0, if available.

status0 indicates that control board 0 is the primary control board (P indicates

primary, and anything else indicates non-primary).

cb1_hostname is the host name for control board 1, if available.

status1 indicates that control board 1 is the primary control board.

For example:

This example indicates that there are two control boards in the xf2 platform. They

are xf2-cb0 and xf2-cb1 . xf2-cb0 is specified as the primary. See the

cb_config (4) man page for more information.

The communication port that is used for communication between the control board

server and the control board executive is specified in

/tftpboot/ xxxxxxxx.cb_port , where xxxxxxxx is the control board IP address

represented in hexadecimal format.

platform_name: platform_type: cb0_hostname: status0: cb1_hostname: status1

xf2:Ultra-Enterprise-10000:xf2-cb0:P:xf2-cb1:
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Control Board Executive Image and Port

Specification Files

The SSP is the boot server for the control board. Two files are downloaded by the

control board boot PROM during boot time: the image of CBEand the port number

specification file. These files are located in /tftpboot on the SSP and the naming

conventions are:

where xxxxxxxx is the control board IP address in hex format.

For example, the files for control board xf2-cb0 are:

If you are using NIS, the IP address of xf2-cb0 can be determined as follows:

The returning address is 129.153.49.147. This can be converted to 81993193.

▼ To Switch the Primary Control Board

Caution – Do not edit the /var/opt/SUNWssp/.ssp_private/cb_config file

manually. Instead, use the ssp_config (1M) command as described below.

Otherwise, your domains may fail and arbitration stops (arbstops) may occur.

1. If any domains are running, shut down those domains using the standard
shutdown (1M) command.

2. Log in to the main SSP as ssp .

3. Power off all of the system boards.

/tftpboot/ xxxxxxxx for the cbe image
/tftpboot/ xxxxxxxx.cb_port for the port number

/tftpboot/81973213
/tftpboot/81973213.cb_port

% ypcat hosts | grep xf2-cb0

ssp% power -off -all
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4. Power on all of the system boards.

5. Log in to the main SSP as superuser.

6. Obtain the host names and IP addresses for the two control boards.

7. Verify that control board IP addresses are set up properly in the
/etc/inet/hosts file or in your local name service system.

8. As superuser, type ssp_config (1M):

In this sample session, the primary control board is switched from snax-cb0 to

snax-cb1 .

Note – The platform name identifies the entire host machine, not a particular domain.

9. Restart the main SSP processes.

ssp% power -on -all

ssp# /opt/SUNWssp/bin/ssp_config cb

Configuring control boards.

Platform name   = snax
Control Board 0 = snax-cb0 => 129.153.49.181
Control Board 1 = snax-cb1 => 129.153.49.182
Primary Control Board = 0

Is this correct? (y/n): n
Do you have a control board 0? (y/n): y
Please enter the host name of the control board 0 [snax-cb0]:
Do you have a control board 1? (y/n): y
Please enter the host name of the control board 1 [snax-cb0]:

Please identify the primary control board.
Is Control Board 0 [snax-cb0] the primary? (y/n) n
Is Control Board 1 [snax-cb1] the primary? (y/n) y

Platform name   = snax
Control Board 0 = snax-cb0 => 129.153.49.181
Control Board 1 = snax-cb1 => 129.153.49.182
Primary Control Board = 1

Is this correct? (y/n): y
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a. Log in as superuser and type:

b. Log in to the SSP as user ssp and type:

Wait until you see the following message:

10. Start Hostview:

Verify that the “J” and “C” symbols are shown on the symbol for Control Board 1 in

the main Hostview screen. This indicates that the JTAG connection and clock

distribution signals are coming from Control Board 1.

If Hostview fails to respond, verify that you can communicate with Control Board 1.

If you are unable to use ping (1M) to communicate with Control Board 1, visually

examine the LEDs to verify that the control board is operating correctly. For

example, verify that the link integrity LED is on. This indicates that the Ethernet

connection is good. If the LEDs are cycling through a pattern, the control board is

booted. If the LEDs are all off or all on continuously (without cycling through a

pattern), the control board is not booted. Try running snoop (1M) on the SSP to

verify that the control boards are communicating correctly.

11. If you have a spare SSP, repeat Step 6 through Step 8 above, on the spare SSP.

12. Issue the bringup (1M) command for all domains.

ssp# /etc/init.d/ssp stop
ssp# /etc/init.d/ssp start

ssp% tail -f $SSPLOGGER/messages

Startup of SSP programs complete

 ssp% hostview &
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CHAPTER 10

SSP Internals

SSP operations are generally performed by a set of daemons and commands. This

chapter provides an overview of how the SSP works and describes the SSP 3.2

daemons, processes, commands, and system files. For more information about

daemons, commands, and system files, refer to the Sun Enterprise 10000 SSP 3.2
Reference Manual.

Caution – Changes made to files in /opt/SUNWssp can cause serious damage to

the system. Only very experienced system administrators should risk changing the

files described in this chapter.

Startup Flow

The events that take place when the SSP boots are as follows:

1. User powers on the SSP (monitor, CPU/disk, and CD-ROM). The SSP boots

automatically.

2. During the SSP boot process, the /etc/rc2.d/s99ssp startup script is called

when the system enters run level 2. This script starts ssp_startup .

3. ssp_startup starts the SSP daemons: machine_server , fad , cbs , straps ,

snmpd, and edd . It also calls cb_reset to start control board initialization.

4. edd initiates event monitoring on the Sun Enterprise 10000 system control board,

waits for an event to be generated by the event detection task running on the

control board, and then responds to the event by running a response action script

on the SSP.

5. After the SSP startup complete message is displayed, you can use SSP 3.2

commands such as domain_create or bringup .
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The SSP uses the event detector daemon, edd (1M), to monitor the Sun Enterprise

10000 system. Each time the SSP boots, it runs /etc/rc2.d/S99ssp , which in turn

loads edd (1M) through the startup script, $SSPETC/ssp_startup.sh . The startup

script checks the environment for availability of certain files and the availability of

the Sun Enterprise 10000 system, sets environment variables, and then starts

edd (1M). edd (1M) obtains many of its initial control parameters from the following

configuration files:

■ $SSPVAR/etc/ platform_name/edd.erc provides configuration information for

the Sun Enterprise 10000 platform.

■ $SSPVAR/etc/ platform_name/ domain_name/edd.erc provides configuration

information for a particular domain. The event response configuration files

(edd.erc ) specify how the event detector will respond to events.

■ $SSPVAR/etc/ platform_name/edd.emc lists the events that edd (1M) will

monitor.

If a domain crashes, edd (1M) invokes the bringup (1M) script. The bringup (1M)

script runs the POST program, which tests Sun Enterprise 10000 components. It then

uses the obp_helper (1M) daemon to download and begin execution of OBP in the

domain specified by the SUNW_HOSTNAMEenvironment variable. This happens only

if a domain fails (for example, after a kernel panic) in which case it is rebooted

automatically. After a halt or shutdown, you must manually run bringup (1M),

which then causes OBP to be downloaded and run.

obp_helper (1M) is responsible for loading download_helper in all the

configured processors’ bootbus SRAM. All the processors are started, with one

processor designated as the boot processor. With the assistance of

download_helper , obp_helper (1M) loads OBP into the memory of the Sun

Enterprise 10000 system and starts OBP on the boot processor. See “OBP Daemon”

on page 82 for more information about obp_helper (1M) and OBP.

The primary task of OBP is to boot and configure the operating system from either a

mass storage device or from a network. OBP also provides extensive features for

testing hardware and software interactively. As part of the boot procedure, OBP

probes all the SBus slots on all the system boards and builds a device tree. This

device tree is passed on to the operating system.

Sun Enterprise 10000 Client/Server
Architecture

The Sun Enterprise 10000 system control board interface is accessed over an Ethernet

connection using the TCP/IP protocol. The control board executive, CBE, runs on

the control board. The control board server, cbs (1M), runs on the SSP and makes

service requests. The SSP control board server provides services to SSP clients.
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FIGURE 10-1 illustrates the Sun Enterprise 10000 system client/server architecture:

FIGURE 10-1 Sun Enterprise 10000 Client/Server Architecture

Note – There is one instance of edd (1M) for the platform supported by the SSP.

There is one instance of obp_helper (1M) and netcon_server (1M) for each

domain on the platform.

Sun Enterprise 10000

Domain Control
Board

CBS

netcon_server snmpd obp_helper

netcon edd hostview post
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POST

Power-on self-test (POST) probes and tests the components of uninitialized Sun

Enterprise 10000 system hardware, configures what it deems worthwhile into a

coherent initialized system, and hands it off to OpenBoot PROM (OBP). POST passes

to OBP a list of only those components that have been successfully tested; those in

the blacklist (4) file are excluded.

hpost (1M) is the SSP-resident executable program that controls and sequences the

operations of POST. hpost (1M) reads directives in the optional file .postrc (see

postrc (4)) before it begins operation with the host.

Caution – Running hpost (1M) outside of the bringup (1M) command can cause

the system to fail. hpost (1M), when run by itself, does not check the state of the

platform, and causes fatal resets.

POST looks at blacklist (4), which is on the SSP, before preparing the system for

booting. blacklist (4) specifies the Sun Enterprise 10000 components that POST

must not configure.

POST stores the results of its tests in an internal data structure called a board
descriptor array. The board descriptor array contains status information for most of

the major components of the Sun Enterprise 10000 system, including information

about the UltraSPARC™ modules.

POST attempts to connect and disconnect each system board, one at a time, to the

system centerplane. POST then connects all the system boards that passed the tests

to the system centerplane.
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Daemons

The SSP 3.2 daemons play a central role on the SSP. Each daemon is fully described

in its corresponding man page. The following table briefly describes the daemons.

TABLE 10-1 Daemons

Name Description

cbs The control board server provides central access to the Sun

Enterprise 10000 control board for client programs running on the

SSP.

edd The event detector daemon initiates event monitoring on the control

boards. When a monitoring task detects an event, edd (1M) runs a

response action script.

fad The file access daemon provides distributed file access services to

SSP clients that need to monitor, read, and write to the SSP

configuration files.

machine_server Provides machine services for netcon (1M) and routes host

messages to proper messages file. See machine_server (1M).

netcon_server The connection point for all netcon (1M) clients.

netcon_server (1M) communicates with OBP using a control

board protocol. netcon_server (1M) communicates with the OS

using the TCP protocol.

obp_helper Runs OpenBoot. obp_helper (1M) terminates when OBP is

terminated. During execution, obp_helper (1M) provides services

to OBP, such as NVRAM simulation, IDPROM simulation, and time

of day.

snmpd The SNMP proxy agent listens to a UDP port for incoming requests

and services the group of objects specified in

Ultra-Enterprise-10000.mib .

straps The SNMP trap sink server listens to the SNMP trap port for

incoming trap messages and forwards received messages to all

connected clients.

xntpd / ntpd The network time protocol (NTP) daemon provides time

synchronization services. (ntpd is the daemon for the Solaris 2.6 and

Solaris 7 operating environments.) Clients can connect to this service

and have their clocks automatically adjusted. This service is used to

synchronize SSP and domain times. See xntpd (1M) and the Network
Time Protocol User’s Guide.
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Event Detector Daemon

The event detector daemon, edd (1M), is a key component in providing the

reliability, availability, and serviceability (RAS) features of Sun Enterprise 10000

system. edd (1M) initiates event monitoring on the Sun Enterprise 10000 control

board, waits for an event to be generated by the event detection monitoring task

running on the control board, and then responds to the event by executing a

response action script on the SSP. The conditions that generate events and the

response taken to events are fully configurable.

edd (1M) provides the mechanism for event management, but does not handle the

event detection monitoring directly. Event detection is handled by an event

monitoring task that runs on the control board. edd (1M) configures the event

monitoring task by downloading a vector that specifies the event types to be

monitored. Event handling is provided by response action scripts, which are

invoked on the SSP by edd (1M) when an event is received.

The RAS features are provided by several collaborative programs. The control board

within the platform runs a control board executive (CBE) program that

communicates through the Ethernet with a control board server (cbs (1M)) program

on the SSP. These two components provide the data link between the platform and

the SSP.

The SSP provides a set of interfaces for accessing the control board through the

control board server and the simple network management protocol (SNMP) agent.

edd (1M) uses the control board server interface to configure the event detection

monitoring task on the control board executive (FIGURE 10-2).

FIGURE 10-2 Uploading Event Detection Scripts

After it is configured, the event detection monitoring task polls various conditions

within the platform, including environmental conditions, signature blocks, power

supply voltages, performance data, and so forth. If an event detection script detects

a change of state that warrants an event, an event message containing the pertinent

information is generated and delivered to the control board server (cbs (1M))

Event detector SNMP
agent

Control board Control board
executiveserver
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running on the SSP. Upon receipt of the event message, the control board server

delivers the event to the SNMP Agent, which in turn generates an SNMP trap

(FIGURE 10-3).

FIGURE 10-3 Event Recognition and Delivery

Upon receipt of an SNMP trap, edd (1M) determines whether to initiate a response

action. If a response action is required, edd (1M) runs the appropriate response

action script as a subprocess (FIGURE 10-4).

FIGURE 10-4 Response Action

Event messages of the same type or related types can be generated while the

response action script is running. Some of these secondary event messages may be

meaningless or unnecessary if a responsive action script is already running for a

similar event; for example, if edd (1M) is running a response action script for a high-

temperature event. While the response action script is running, additional high

temperature events can be generated by the event monitoring scripts. edd (1M) does

not respond to those high temperature events (generated in response to the same
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high temperature condition) until the first response script has finished. It is the

responsibility of applications (such as edd (1M)) to filter the events they will respond

to as necessary. The cycle of event processing is completed at this point.

Control Board Server

The control board server (CBS) runs on the SSP. Whenever a client program running

on the SSP needs to access the Sun Enterprise 10000 system, the communication is

funneled through cbs (1M). cbs (1M), in turn, communicates directly with a control

board Executive (CBE) running on one of the control boards in the Sun Enterprise

10000 system. cbs (1M) converts client requests to the control board management

protocol (CBMP) that is understood by CBE. The following diagram (FIGURE 10-5)

shows how the CBS and CBEs are connected.

FIGURE 10-5 CBS Communication Between SSP and Sun Enterprise 10000 System

cbs (1M) relies on the cb_config (4) file to determine the platform it is to manage,

and the control board with which it is to interact. The cb_config (4) file specifies

the platforms managed by the SSP. Do not directly modify this file; it is

automatically maintained by domain management tools and commands. To make a

control board change, use ssp_config (1M) with the cb option.

TCP/IP Network

Sun Enterprise 10000
platform

CBE Control
board 0

Control
board 1CBE

CBSClient
(Hostview)

SSP
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File Access Daemon

The file access daemon (fad (1M)) is used when ssp_to_domain_hosts (4) or any

other configuration file is updated. fad (1M) provides distributed file access services,

such as file locking, to all SSP clients that need to monitor, read, and write changes

to SSP configuration files. Once a file is locked by a client, other clients are prevented

from locking that file until the first client releases the lock.

Network Time Protocol Daemon

The NTP daemon (ntpd (1M) for the Solaris 2.6 and Solaris 7 operating

environments) provides a mechanism for keeping the time settings synchronized

between the SSP and the domains. OBP obtains the time from the SSP when the

domain is booted, and NTP keeps the time synchronized from that point on.

The configuration is based on information provided by the system administrator. If

the Sun Enterprise 10000 system is not currently running in an NTP subnet, does not

have access to the Internet, and is not going to use a radio clock, you can set up the

Sun Enterprise 10000 system to use its own internal time-of-day clock as the

reference clock. Usually, however, the SSP uses its internal time-of-day clock for the

Sun Enterprise 10000 system.

The NTP packages are compiled with support for a local reference clock. This means

that your system can poll itself for the time instead of polling another system or

network clock. The poll is done through the network loopback interface. The first

three numbers in the IP address are 127.127.1. The last numbers in the IP address are

the NTP stratum to use for the clock.

When setting up domains on an Sun Sun Enterprise 10000 system and its SSP, set the

SSP to stratum 4. Set up the domains as a peer to the SSP and set the local clock at

least one stratum higher than the SSP.

An example of server/peer lines in the /etc/opt/SUNWxntp/ntp.conf file on the

SSP is shown below.

You can add the following example lines to the /etc/inet/ntp.conf file on the

domains:

server 127.127.1.4

server ssp_name
server 127.127.1.13 stratum 13
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For more information on the NTP daemon, refer to the Network Time Protocol User’s
Guide and the NTP Reference Manual.

OBP Daemon

On the SSP, OpenBoot (OBP) is not a hardware PROM; it is loaded from a file on the

SSP. An SSP file also replaces the traditional OBP NVRAM and idprom (hostid ).

The OBP file is located under a directory path that is specific to the SunOS release.

(Note that SunOS 5.6 corresponds to the Solaris 2.6 operating environment and

SunOS 5.7 corresponds to the Solaris 7 operating environment. You can determine

your SunOS version with uname -r .) For example, under SunOS 5.7, the OBP file is

located in the following directory:

/opt/SUNWssp/release/Ultra-Enterprise-10000/5/7/hostobjs/obp

where the /5/7 portion of the path corresponds to the SunOS version number. If

your release contains a different version of the operating system, that portion of the

path will be different.

bringup (1M) starts obp_helper (1M) in the background, which kills the previous

obp_helper (1M), if one exists. obp_helper (1M) runs download_helper and

subsequently downloads and runs OBP.

obp_helper (1M) is essential in starting processors other than the boot processor. It

communicates with OBP through bootbus SRAM (BBSRAM), responding to requests

to supply the time-of-day, get or put the contents of the pseudo-EEPROM, and

release slave processors when in multiprocessor mode. To release the slave

processors, obp_helper (1M) must load download_helper into the BBSRAM of all

the slave processors, place an indication in BBSRAM that it is a slave processor, then

start the processor by releasing the bootbus controller reset.

For more information, see the obp_helper (1M), and bringup (1M) man pages and

“download_helper File” on page 84.
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Environment Variables

Most of the necessary environment variables are set when the ssp user logs in.

TABLE 10-2 describes the environment variables.

Executable Files Within a Domain

Executable files that are run within a domain reside in the

/opt/SUNWssp/release/Ultra-Enterprise-10000/ os_version directory. The

man pages for these programs reside within the domain.

Some of the commands listed in this section must be used or modified only by your

service provider; they are normally called internally by other programs rather than

run on the command line.

Caution – Improper use of these commands can result in failure or damage to the

system. If you are not sure of the function of any command, contact your service

provider for assistance.

*.elf Files

These are executable files that are downloaded by hpost (1M).

TABLE 10-2 Environment Variables

SUNW_HOSTNAME The name of the domain controlled by the SSP.

SSPETC The path to the directory containing miscellaneous SSP-related

files.

SSPLOGGER The location of the configuration file for message logging. You

should never change the value of this environment variable.

SSPOPT The path to the SSP package binaries, libraries, and object files.

SSPVAR The path to the directory where modifiable files reside.
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download_helper File

download_helper enables programs to be downloaded to the memory used by a

domain instead of BBSRAM. This provides an environment in which host programs

can run without having to know how to relocate themselves to memory. These

programs can be larger than BBSRAM.

download_helper works by running a protocol through a mailbox in BBSRAM.

The protocol has commands for allocating and mapping physical to virtual memory,

and for moving data between a buffer in BBSRAM and virtual memory. When

complete, the thread of execution is usually passed to the new program at an entry

point provided by the SSP. After this occurs, download_helper lives on in

BBSRAM so it can provide reset handling services. Normally, you do not need to be

concerned with the download helper; it is used only by the obp_helper (1M)

daemon. See the obp_helper (1M) man page for more information.

obp File

The obp file is fundamental to the boot process of a domain. OBP knows how to

probe the SBus to determine which devices are connected where, and provides this

information to the operating system in the form of a device tree. The device tree is

ultimately visible using the command prtconf (for more information, see the

SunOS prtconf (1M) man page).

obp also interprets and runs FCode on SBus cards, which provides loadable, simple

drivers for accomplishing boot. In addition, it provides a kernel debugger, which is

always loaded.
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Glossary

Alternate Pathing
(AP) AP enables you to set up an alternate path to system components in case of

failure, repair, or replacement.

AP See Alternate Pathing (AP).

application specific
integrated circuit

(ASIC) In the Sun Enterprise 10000 system, any of the large main chips in the design,

including the UltraSPARC processor and data buffer chips.

arbitration stop A condition that occurs when one of the Sun Enterprise 10000 system ASICs

detects a parity error or equivalent fatal system error. Bus arbitration is frozen,

so all bus activity stops. The system is down until the SSP detects the condition

by polling the Control and Status Registers CSRs of the Address Arbiter ASICs

through JTAG, and clears the error condition.

ASIC See application specific integrated circuit (ASIC).

BBSRAM See bootbus SRAM (BBSRAM).

blacklist A text file that hpost (1M) reads when it starts up. The blacklist file specifies

the Sun Enterprise 10000 system components that are not to be used or

configured into the system. The default path name for this file can be

overridden in the .postrc file (see postrc (4)) and on the command line.

board descriptor
array The description of the single configuration that hpost (1M) chooses. It is part

of the structure handed off to OBP.

bootbus A slow-speed, byte-wide bus controlled by the processor port controller ASICs,

used for running diagnostics and boot code. UltraSPARC starts running code

from bootbus when it exits reset. In the Sun Enterprise 10000 system, the only

component on the bootbus is the BBSRAM.
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bootbus SRAM
(BBSRAM) A 256-Kbyte static RAM attached to each processor PC ASIC. Through the PC,

it can be accessed for reading and writing from JTAG or the processor. Bootbus

SRAM is downloaded at various times with hpost (1M) and OBP startup code,

and provides shared data between the downloaded code and the SSP.

control and status
register (CSR) A general term for any embedded register in any of the ASICS in the Sun

Enterprise 10000 system.

CSR See control and status register (CSR).

DIMM See dual in-line memory module (DIMM).

domain A set of one or more system boards that acts as a separate system capable of

booting the OS and running independently of any other domains.

DRAM See dynamic RAM (DRAM).

dual in-line memory
module (DIMM) A small printed circuit card containing memory chips and some support logic.

dynamic RAM
(DRAM) Hardware memory chips that require periodic rewriting to retain their

contents. This process is called “refresh”. In the Sun Enterprise 10000 system,

DRAM is used only on main memory SIMMs and on the control boards.

Ecache See external cache (Ecache).

external cache
(Ecache) A 0.5-Mbyte to 4-Mbyte synchronous static RAM second-level cache local to

each processor module. Used for both code and data. This is a direct-mapped

cache.

JTAG A serial scan interface specified by IEEE standard 1149.1. The name comes from

Joint Test Action Group, which initially designed it. See JTAG+.

JTAG+ An extension of JTAG, developed by Sun Microsystems Inc., which adds a

control line to signal that board and ring addresses are being shifted on the

serial data line. Often referred to simply as JTAG.

OBP See OpenBoot PROM (OBP).

OpenBoot PROM
(OBP) A layer of software that takes control of the configured Sun Enterprise 10000

system from hpost (1M), builds some data structures in memory, and boots the

operating system.

POST See power-on self-test.
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power-on self-test
(POST) A test performed by hpost (1M). This is the program that takes uninitialized

Sun Enterprise 10000 system hardware and probes and tests its components,

configures what seems worthwhile into a coherent initialized system, and

hands it off to OBP.

.postrc A text file that controls options in hpost (1M). Some of the functions can also

be controlled from the command line. Arguments on the command line take

precedence over lines in the .postrc file, which takes precedence over built-in

defaults. hpost -? postrc gives a terse reminder of the .postrc options

and syntax. See postrc (4).

SBus A Sun Microsystems Inc. designed I/O bus, now an open standard.

SRAM See static RAM (SRAM).

static RAM (SRAM) Memory chips that retain their contents as long as power is maintained.

SSP See System Service Processor (SSP).

System Service
Processor (SSP) A workstation or server containing software for controlling power sequencing,

diagnostics, and booting of a Sun Enterprise 10000 system.

UltraSPARC The UltraSPARC processor is the processor module used in the Sun Enterprise

10000 system.
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power, 47
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ssp_restore, 63
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Configuration menu
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control boards, 69
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daemons

edd, 78
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SSP, 77

xntpd, 77

DIMM, 86

display

netcon window, 36

netcontool window, 38

domain status

with Hostview, 33

domain_create, 26

domain_remove, 30

example, 30

domain_rename, 32

domains, 1

bringing up, 32

bringing up with Hostview, 32

creating, 24, 26

domain name, 25

removing, 30

renaming, 30

status, 33

download_helper command, 84

DRAM, 86

dual control boards, 3

Dynamic System Domains, 1

E
edd daemon, 78

Edit menu

Hostview, 14

elf files, 83

environment variables, 83

SSPETC, 83

SSPLOGGER, 83

SSPOPT, 83

SSPVAR, 83

SUNW_HOSTNAME, 83

error message file, 21

event detector daemon (edd), 78

exclusive session permission

netcon, 35

external cache, 86

F
failure button

Hostview, 19

fan button

Hostview, 18

Fan Status Display window, 53

fan tray window, 55

Hostview, 55

fans

controlling in Hostview, 55

controlling speed, 56

monitoring in Hostview, 53

File menu

Hostview, 14

files

error messages, 21

H
Help

Hostview, 16

Hostview

blacklisting components, 58

blacklisting processors, 59

bringing up a domain, 32

buttons, 18

clear blacklist file, 61

Configuration menu, 14

Control menu, 14

controlling fans, 55

creating domains, 24

displaying netcontool window, 39

domain status, 33

Edit menu, 14

failure button, 19

fan button, 18

Fan Status Display window, 53

File menu, 14

Help, 16

icons, 19

main window, 11

menu bar, 14

monitoring fans, 53

monitoring power levels, 47

monitoring temperature, 51

performance considerations, 20

power button, 18

powering components on or off, 45
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processor colors, 20

processor symbols, 19

renaming domains, 30

selected system board, 12

selecting items in main window, 13

SSP Logs window, 21

starting Hostview, 9

swap space, 20

temperature button, 18

Terminal menu, 15

Thermal Detail window, 52

unselected system board, 12

View menu, 16

viewing messages file, 21

I
icons

Hostview, 19

J
JTAG, 86

L
locked write permission

netcon, 35

log file, 14, 21

logging

disabling for netcon, 43

enabling for netcon, 43

M
menu bar

Hostview, 14

messages file

viewing, 21

monitoring

fans, 53

temperature, 51

N
netcon, 6, 35

communication paths for console I/O, 42

disabling logging, 43

displaying window, 36

enabling logging, 43

exclusive session, 42

exclusive sessions permission, 35

locked write, 42

locked write permission, 35

read only session, 41

unlocked write, 41

unlocked write permission, 35

netcontool

buttons, 37

configuration window, 40

displaying from Hostview, 39

displaying window, 38

network console window, 6

O
OBP, 86

obp command, 84

OBP See OpenBoot PROM

obp_helper daemon, 77

OpenBoot PROM, 74, 82, 86

P
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